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1 Product introduction

● Product comparison

● Product views

● Product hardware setup and software installation

For more information:

In the US, go to www.hp.com/support/ljM701 or www.hp.com/support/ljM706.

Outside the US, go to www.hp.com/support. Select your country/region. Click Troubleshooting. Enter the
product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Product comparison
Model name

Model
number

 M701a

B6S00A

M701n

B6S01A

M706n

B6S02A

Paper
handling

Tray 1 (100-sheet multipurpose tray)

Tray 2 (250-sheet input tray)

Tray 3 (500-sheet input tray accessory)   Optional

250-sheet output bin

Duplex printing accessory   Optional

Supported
operating
systems

Windows XP, 32-bit (Service Pack 2 and higher)

Windows Vista, 32-bit and 64-bit

Windows 7, 32-bit and 64-bit

Windows 8 and 8.1, 32-bit and 64-bit (print driver only)

Windows Server 2003, 32-bit and 64-bit (print driver
only)

Windows Server 2003 R2, 32-bit (print driver only)

Windows Server 2008, 32-bit and 64-bit (Service Pack 2;
print driver only)

Windows Server 2008 R2, 32-bit and 64-bit (print driver
only)

Windows Server 2012 (print driver only)

Windows Server 2012 R2 (print driver only)

Mac OS X v10.6, OS X v10.7 Lion, OS X v10.8 Mountain
Lion, and OS X v10.9 Mavericks

Supported
print drivers

The HP PCL 6 print driver is included on the in-box CD as
the default print driver. It is automatically installed
unless you select a different one.

For more information and additional driver options, go to
www.hp.com/support.

Connectivity Hi-Speed USB 2.0

10/100 Ethernet LAN connection  

Memory 256 MB DDR3 RAM

Control-
panel display

Two-line LCD screen   

Two-line LCD screen with ePrint button  
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Model name

Model
number

 M701a

B6S00A

M701n

B6S01A

M706n

B6S02A

Print Prints 31 pages per minute (ppm) on A4-size paper, prints
30 ppm on Letter-size paper, and prints 15 ppm on A3-
size paper

 

Prints 35 ppm on A4-size and Letter-size paper, prints
18.5 ppm on A3-size paper

  

Print resolution is up to 1200x1200 dpi

Supports HP ePrint  
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Product views
Product front view

1

6

7
8

2

3

4

5
1 Control panel

2 On/off button

3 Tray 1 (pull the handles on the sides to open)

4 Tray 2

5 Optional Tray 3 (M706n model only)

6 Latch to open the front door (access to the toner cartridge)

NOTE: The serial number and model number label is on the inside of the front door.

7 Output-bin extension for long paper

8 Output bin
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Product back view

3

2

1

4

1 Rear door (provides access for clearing jams)

2 Duplex unit door

3 Power connection

4 Port cover
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Interface ports

1

2

1 Network port (M701n and M706n models only)

2 Hi-Speed USB 2.0 port

6 Chapter 1   Product introduction ENWW



Control panel layout

1 Control-panel display: The display provides information about the product. Use the menus on the display to establish product
settings.

2 Attention light (amber): The Attention light blinks when the product requires user attention.

3 Ready light (green): The Ready light is on when the product is ready to print. It blinks when the product is receiving print data, or
when the product is in sleep mode.

4 Back  button: Use this button for the following actions:

● Exit the control-panel menus.

● Scroll back to a previous menu in a submenu list.

● Scroll back to a previous menu item in a submenu list (without saving changes to the menu item).

5 Cancel  button: Press this button to cancel a print job whenever the attention light is blinking or to exit the control-panel
menus.

6 Left arrow  button: Use this button to navigate through the menus or to decrease a value that appears on the display.

7 OK button: Press the OK button for the following actions:

● Open the control-panel menus.

● Open a submenu displayed on the control-panel display.

● Select a menu item.

● Clear some errors.

● Begin a print job in response to a control-panel prompt (for example, when the message Press OK to continue appears on
the control-panel display).

8 Right arrow  button: Use this button to navigate through the menus or to increase a value that appears on the display.

9 ePrint  button: This button provides quick access to HP ePrint features. HP ePrint is a tool that prints documents by using
any email-enabled device to send them to the product email address.

(M701n and M706n models only)

10 On/off button: This button provides power to the product.
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Product hardware setup and software installation
For basic setup instructions, see the Hardware Installation Guide that came with the product. For additional
instructions, go to HP support on the Web.

In the US, go to www.hp.com/support/ljM701 or www.hp.com/support/ljM706 for HP's all-inclusive help for
your product.

Outside the US, follow these steps:

1. Go to www.hp.com/support.

2. Select your country/region.

3. Click Troubleshooting.

4. Enter the product name (HP LaserJet Pro M701/M706), and then select Search.

Find the following support:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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2 Paper trays

● Load Tray 1 (multipurpose tray)

● Load Tray 2

● Load Tray 3 (M706n model only)

For more information:

In the US, go to www.hp.com/support/ljM701 or www.hp.com/support/ljM706.

Outside the US, go to www.hp.com/support. Select your country/region. Click Troubleshooting. Enter the
product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Load Tray 1 (multipurpose tray)
NOTE: Tray 1 holds up to 100 sheets of paper, up to 75 transparencies, up to 50 sheets of labels, or up to
10 envelopes. It supports cut sheet paper weight 60–199 g/m2 (16–53 lb); labels and transparencies 0.10 to
0.14 mm thick (4.7 to 5 mils thick); envelopes weight 60 to 90 g/m2 (16 to 24 lb); and postcards weight 135 to
176 g/m2 (36-47 lb).

For information about the correct paper orientation for loading paper in this tray, see Tray 1 paper
orientation on page 13.

1. Open Tray 1 by grasping the handles on each side
of the tray and pulling down.

 

2. Slide out the tray extension.  
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3. For long paper, fold out the tray extension to
support the paper.

 

4. Adjust the paper guides.  
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5. Load the paper into the tray. Make sure that the
paper fits under the tabs and below the
maximum-height indicators.

The way you should orient the paper in the tray
varies depending on the paper size. For
additional information, see Tray 1 paper
orientation on page 13.

 

6. Adjust the paper guides so that they lightly touch
the paper stack but do not bend the paper.

 

NOTE: To avoid jams, do not add paper to Tray 1 while the product is printing. Do not close Tray 1 while the
product is printing.
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Tray 1 paper orientation

Paper type Paper size How to load paper

Cut sheet paper Letter, A4, A5, B5, Executive, 16K, and
custom sizes

Long edge leading into the product

 A3, B4, 11 x 17, Legal, Oficio 8.5 x 13,
and custom sizes

Short edge leading into the product

Preprinted, prepunched, or letterhead Letter, A4, A5, B5, Executive, 16K, and
custom sizes

Face-up

Long edge leading into the product with the top of the page to
the right of the tray

 A3, B4, 11 x 17, Legal, Oficio 8.5 x 13,
and custom sizes

Face-up

Top edge leading into the product

ENWW Load Tray 1 (multipurpose tray) 13



Paper type Paper size How to load paper

Labels Any compatible label size Face up

Envelopes Any compatible envelope size Face-up

Top edge toward the right of the tray, postage end entering
the product last
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Load Tray 2
Tray 2 holds up to 250 sheets of 75 g/m2 (20 lb) paper. If the paper is heavier, the tray does not hold as many
sheets. Do not overfill the tray. It supports cut sheet paper weight 60–120 g/m2 (16–32 lb).

For information about the correct paper orientation for loading paper in this tray, see Tray 2 paper
orientation on page 18.

CAUTION: Do not print envelopes, labels, or unsupported sizes of paper from Tray 2. Print these types of
paper only from Tray 1.

1. Pull the tray out and lift up slightly to remove it
completely from the product.

NOTE: Do not open the tray while it is in use.

 

2. Pinch the release that is located on the left guide
and slide the side guides to the correct paper
size.
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3. If you are loading B4, A3, 11 x 17, Legal, or Oficio
8.5 x 13 size paper, unlock the rear tray guide
using the slide lock at the back of the tray.

 

4. Adjust the tray length to the correct paper size.  

5. Load paper into the tray. Check the paper to
make sure the guides lightly touch the stack, but
do not bend the paper.

The way you should orient the paper in the tray
varies depending on the paper size. For
additional information, see Tray 2 paper
orientation on page 18.

NOTE: To prevent jams, do not overfill the tray.
Be sure the top of the stack is below the tray full
indicator.

NOTE: If the tray is not adjusted correctly, an
error message might display during printing or
the paper might jam.
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6. Slide the tray completely into the product.  

7. On the product control panel, follow the onscreen
message to configure the paper tray. If you miss
the control panel message, complete the
following steps to configure the tray.

a. On the product control panel, press the OK
button.

b. Open the following menus:

System Setup

Paper Setup

Tray 2

c. Open the Paper Size menu, select the correct
size, and then press the OK button.

d. Open the Paper Type menu, select the
correct type, and then press the OK button.
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Tray 2 paper orientation

Paper type Paper size How to load paper

Cut sheet paper Letter, A4, A5, B5, Executive, 16K, and
custom sizes

Long edge along the front of the tray

 A3, B4, 11 x 17, Legal, Oficio 8.5 x 13,
and custom sizes

Long edge along the side of the tray

Preprinted, prepunched, or letterhead Letter, A4, A5, B5, Executive, 16K, and
custom sizes

Face-down

Top edge at the right of the tray

 A3, B4, 11 x 17, Legal, Oficio 8.5 x 13,
and custom sizes

Face-down

Top edge at the front of the tray
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Load Tray 3 (M706n model only)
Optional Tray 3 holds up to 500 sheets of 75 g/m2 (20 lb) paper. If the paper is heavier, the tray does not hold
as many sheets. Do not overfill the tray. It supports cut sheet paper weight 60–120 g/m2 (16–32 lb).

For information about the correct paper orientation for loading paper in this tray, see Tray 3 paper
orientation on page 22.

NOTE: Do not print envelopes, labels, or unsupported sizes of paper from Tray 3. Print these types of paper
only from Tray 1.

1. Pull the tray out and lift up slightly to remove it
completely from the product.

NOTE: Do not open the tray while it is in use.

 

3

2. Pinch the release that is located on the left guide
and slide the side guides to the correct paper
size.

 

3
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3. Adjust the paper length to the correct paper size.  

3

4. Load paper into the tray. Check the paper to
make sure the guides lightly touch the stack, but
do not bend the paper.

The way you should orient the paper in the tray
varies depending on the paper size. For
additional information, see Tray 3 paper
orientation on page 22.

NOTE: To prevent jams, do not overfill the tray.
Be sure the top of the stack is below the tray full
indicator.

NOTE: If the tray is not adjusted correctly, an
error message might display during printing or
the paper might jam.

 

3
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5. Slide the tray completely into the product.  

3

6. On the product control panel, follow the onscreen
message to configure the paper tray. If you miss
the control panel message, complete the
following steps to configure the tray.

a. On the product control panel, press the OK
button.

b. Open the following menus:

System Setup

Paper Setup

Tray 3

c. Open the Paper Size menu, select the correct
size, and then press the OK button.

d. Touch Paper Type menu, select the correct
type, and then press the OK button.

 

ENWW Load Tray 3 (M706n model only) 21



Tray 3 paper orientation

Paper type Paper size How to load paper

Cut sheet paper Letter, A4, A5, B5, Executive, 16K, and
custom sizes

Long edge along the front of the tray

3

 A3, B4, 11 x 17, Legal, Oficio 8.5 x 13,
and custom sizes

Long edge along the side of the tray

3

Preprinted, prepunched, or letterhead Letter, A4, A5, B5, Executive, 16K, and
custom sizes

Face-down

Top edge at the right of the tray

3

 A3, B4, 11 x 17, Legal, Oficio 8.5 x 13,
and custom sizes

Face-down

Top edge at the front of the tray

3
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3 Parts, supplies, and accessories

● Order parts, accessories, and supplies

● Replace the toner cartridge

For more information:

In the US, go to www.hp.com/support/ljM701 or www.hp.com/support/ljM706.

Outside the US, go to www.hp.com/support. Select your country/region. Click Troubleshooting. Enter the
product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Order parts, accessories, and supplies
Ordering

Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Order using the HP Embedded Web Server (EWS) To access, in a supported Web browser on your computer, enter
the product IP address or host name in the address/URL field. The
EWS contains a link to the HP SureSupply Web site, which
provides options for purchasing Original HP supplies.

Parts and supplies
The following customer self-repair parts are available for the product.

● Parts listed as Mandatory self-replacement are to be installed by customers, unless you are willing to
pay HP service personnel to perform the repair. For these parts, on-site or return-to-depot support is
not provided under the HP product warranty.

● Parts listed as Optional self-replacement can be installed by HP service personnel at your request for
no additional charge during the product warranty period.

Item Description Self-replacement options Part number

HP 93A Black LaserJet Toner
Cartridge

Replacement toner cartridge Mandatory CZ192-67901

Tray 1 Roller Kit Replacement rollers for Tray 1 Optional A3E42-65018

Tray 2 Roller Kit Replacement rollers for Tray 2 Optional A3E42-65019

Tray 3 Roller Kit Replacement rollers for optional
Tray 3

Optional A3E42-65011

Tray 2 Assembly Kit Replacement Tray 2 Mandatory RM2-0629-000

Optional accessory Duplex unit Replacement optional duplex
printing accessory

Mandatory A3E46-67901

Optional accessory 500 Sheet
Feeder Tray 3

Replacement optional 500-sheet
feeder (Tray 3)

Mandatory A3E47-67901

Accessories

Item Description Part number

HP LaserJet 1 x 500 Paper Feeder 500-sheet paper feeder (optional Tray 3) A3E47A

HP LaserJet Duplex Printing Accessory Optional automatic duplexer A3E46A

USB cable 2-meter standard USB-compatible device
connector

C6518A
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Replace the toner cartridge
When a toner cartridge approaches the end of useful life, you are prompted to order a replacement. You can
continue printing with the current cartridge until redistributing the toner no longer yields acceptable print
quality.

The following illustration shows the toner-cartridge components.

2 3

1

1 Imaging drum (Be careful not to touch the imaging drum.)

2 Memory chip

3 Sealing tape

1. Open the front door.  
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2. Remove the used toner cartridge.  

3. Remove the new toner cartridge from the bag.
Place the used toner cartridge in the bag for
recycling.

 

4. Grasp both sides of the toner cartridge and
distribute the toner by gently rocking the
cartridge.

CAUTION: Do not touch the imaging drum.
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5. Remove the sealing tape. Bend the tab on the left
side of the cartridge until the tab breaks loose.
Pull the tab until all the tape is removed from the
cartridge. Place the tab and tape in the toner-
cartridge box to return for recycling.

 

6. Align the toner cartridge with the tracks inside
the product, insert the toner cartridge until it is
firmly seated.

 

7. Close the front door.  
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4 Print

● Print tasks (Windows)

● Print tasks (Mac OS X)

● Mobile printing

For more information:

In the US, go to www.hp.com/support/ljM701 or www.hp.com/support/ljM706.

Outside the US, go to www.hp.com/support. Select your country/region. Click Troubleshooting. Enter the
product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Print tasks (Windows)
● How to print (Windows)

● Automatically print on both sides (Windows)

● Manually print on both sides (Windows)

● Print multiple pages per sheet (Windows)

● Select the paper type (Windows)

● Additional print tasks

How to print (Windows)
The following procedure describes the basic printing process for Windows.

1. From the software program, select the Print option.

2. Select the product from the list of printers. To change settings, click or tap the Properties or
Preferences button to open the print driver.

NOTE: The name of the button varies for different software programs.
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3. Click or tap the tabs in the print driver to configure the available options. For example, set the paper
orientation on the Finishing tab, and set the paper source, paper type, paper size, and quality settings
on the Paper/Quality tab.

4. Click or tap the OK button to return to the Print dialog box. Select the number of copies to print from
this screen.

5. Click or tap the OK button to print the job.
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Automatically print on both sides (Windows)
Use this procedure for products that have an automatic duplexer installed. If the product does not have an
automatic duplexer installed, or to print on paper types that the duplexer does not support, you can print on
both sides manually.

1. From the software program, select the Print option.

2. Select the product from the list of printers, and then click or tap the Properties or Preferences button
to open the print driver.

NOTE: The name of the button varies for different software programs.

3. Click or tap the Finishing tab.

4. Select the Print on both sides check box. Click the OK button to close the Document Properties dialog
box.

5. In the Print dialog box, click the OK button to print the job.
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Manually print on both sides (Windows) 
Use this procedure for products that do not have an automatic duplexer installed or to print on paper that the
duplexer does not support.

1. From the software program, select the Print option.

2. Select the product from the list of printers, and then click or tap the Properties or Preferences button
to open the print driver.

NOTE: The name of the button varies for different software programs.

3. Click or tap the Finishing tab.

4. Select the Print on both sides (manually) check box. Click the OK button to print the first side of the
job.

5. Retrieve the printed stack from the output bin, and place it in Tray 1.

6. If prompted, touch the appropriate control panel button to continue.
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Print multiple pages per sheet (Windows)
1. From the software program, select the Print option.

2. Select the product from the list of printers, and then click or tap the Properties or Preferences button
to open the print driver.

NOTE: The name of the button varies for different software programs.

3. Click or tap the Finishing tab.

4. Select the number of pages per sheet from the Pages per sheet drop-down list.

5. Select the correct Print page borders, Page order, and Orientation options. Click the OK button to close
the Document Properties dialog box.

6. In the Print dialog box, click the OK button to print the job.
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Select the paper type (Windows)
1. From the software program, select the Print option.

2. Select the product from the list of printers, and then click or tap the Properties or Preferences button
to open the print driver.

NOTE: The name of the button varies for different software programs.

3. Click or tap the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper.

7. Select the option for the type of paper you are using, and then click the OK button.

8. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK
button to print the job.

Additional print tasks
In the US, go to www.hp.com/support/ljM701 or www.hp.com/support/ljM706.

Outside the US, go to www.hp.com/support. Select your country/region. Click Troubleshooting. Enter the
product name, and then select Search.

Instructions are available for performing specific print tasks, such as the following:

● Create and use printing shortcuts or presets

● Select the paper size, or use a custom paper size

● Select the page orientation

● Create a booklet

● Scale a document to fit a specific paper size

● Print the first or last pages of the document on different paper

● Print watermarks on a document
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Print tasks (Mac OS X)
● How to print (Mac OS X)

● Automatically print on both sides (Mac OS X)

● Manually print on both sides (Mac OS X)

● Print multiple pages per sheet (Mac OS X)

● Select the paper type (Mac OS X)

● Additional print tasks

For more information, see www.hp.com/support.

How to print (Mac OS X)
The following procedure describes the basic printing process for Mac OS X.

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. Open the menus drop-down list or click Show Details, and then select other menus to adjust the print
settings.

4. Click the Print button.

Automatically print on both sides (Mac OS X)

NOTE: This feature is available if you install the HP print driver. It might not be available if you are using
AirPrint.

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. Open the menus drop-down list or click Show Details, and then click the Layout menu.

4. Select a binding option from the Two-Sided drop-down list.

5. Click the Print button.

Manually print on both sides (Mac OS X)

NOTE: This feature is available if you install the HP print driver. It might not be available if you are using
AirPrint.

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select this product.

3. Open the menus drop-down list or click Show Details, and then click the Manual Duplex menu.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button.

36 Chapter 4   Print ENWW

http://www.hp.com/support


6. Go to the product, and remove any blank paper that is in Tray 1.

7. Retrieve the printed stack from the output bin and place it with the printed-side facing down in the input
tray.

8. If prompted, touch the appropriate control panel button to continue.

Print multiple pages per sheet (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. Open the menus drop-down list or click Show Details, and then click the Layout menu.

4. From the Pages per Sheet drop-down list, select the number of pages that you want to print on each
sheet.

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

7. Click the Print button.

Select the paper type (Mac OS X)
1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. Open the menus drop-down list or click Show Details, and then click the Finishing menu.

4. Select a type from the Media-type drop-down list.

5. Click the Print button.

Additional print tasks
In the US, go to www.hp.com/support/ljM701 or www.hp.com/support/ljM706.

Outside the US, go to www.hp.com/support. Select your country/region. Click Troubleshooting. Enter the
product name, and then select Search.

Instructions are available for performing specific print tasks, such as the following:

● Create and use printing shortcuts or presets

● Select the paper size, or use a custom paper size

● Select the page orientation

● Create a booklet

● Scale a document to fit a specific paper size

● Print the first or last pages of the document on different paper

● Print watermarks on a document
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Mobile printing
HP offers multiple Mobile and ePrint solutions to enable wireless printing to an HP printer from a laptop,
tablet, smartphone, or other mobile device. To determine the best choice, go to www.hp.com/go/
LaserJetMobilePrinting (English only).

● Wireless network printing

● HP ePrint via email

● HP ePrint software

● AirPrint

Wireless network printing
For information on printing wirelessly to products connected to the wireless network, go to HP support on
the Web:

● In the US, go to www.hp.com/support/ljM701 or www.hp.com/support/ljM706.

● Outside the US, go to www.hp.com/support. Select your country/region. Click Troubleshooting. Enter
the product name, and then select Search.

Then, from the product's support home page, select Setup & Install, Product setup and install, Wireless
setup.

HP ePrint via email
Use HP ePrint to print documents by sending them as an email attachment to the product's email address
from any email enabled device.

To use HP ePrint, the product must meet these requirements:

● The product must be connected to a wired network and have Internet access.

● HP Web Services must be enabled on the product, and the product must be registered with
HP Connected.

1. On the product control panel, press the OK button.

2. Scroll to the HP Web Services menu, and press the OK button.

3. Scroll to the Print Information Sheet option, and press the OK button.

The information page contains the printer code that you use to register your HP product at
HP Connected.

4. Go to www.hpconnected.com to create an HP ePrint account and complete the setup process.

For more information, go to www.hp.com/support to review additional support information for your product.

HP ePrint software
The HP ePrint software makes it easy to print from a Windows or Mac desktop or laptop computer to any HP
ePrint-capable product. This software makes it easy to find HP ePrint-enabled products that are registered to
your HP Connected account. The target HP printer can be located in the office or at locations across the
globe.
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● Windows: After installing the software, open the Print option from within your application, and then
select HP ePrint from the installed printers list. Click the Properties button to configure print options.

● Mac: After installing the software, select File, Print, and then select the arrow next to PDF (in the
bottom left of the driver screen). Select HP ePrint.

For Windows, the HP ePrint software supports TCP/IP printing to local network printers on the network (LAN
or WAN) to products that support UPD PostScript®.

Windows and Mac both support IPP printing to LAN or WAN network-connected products that support ePCL.

Windows and Mac also both support printing PDF documents to public print locations and printing using HP
ePrint via email through the cloud.

Go to www.hp.com/go/eprintsoftware for drivers and information.

NOTE: The HP ePrint software is a PDF workflow utility for Mac, and is not technically a print driver.

NOTE: HP ePrint Software does not support USB printing.

AirPrint
Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to the
product from an iPad, iPhone (3GS or later), or iPod touch (third generation or later) in the following
applications:

● Mail

● Photos

● Safari

● iBooks

● Select third-party applications

To use AirPrint, the product must be connected to the same wireless network as the Apple device. For more
information about using AirPrint and about which HP products are compatible with AirPrint, go to the support
Web site for this product:

● In the US, go to www.hp.com/support/ljM701 or www.hp.com/support/ljM706.

● Outside the US, go to www.hp.com/support. Select your country/region. Click Troubleshooting. Enter
the product name, and then select Search.

NOTE: AirPrint does not support USB connections.
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5 Manage the product

● Change the product connection type (Windows)

● Configure IP network settings

● Advanced configuration with HP Embedded Web Server (EWS) and HP Device Toolbox (Windows)

● HP Utility for Mac OS X

● HP Web Jetadmin

● Product security features

● Economy settings

● Update the firmware

For more information:

In the US, go to www.hp.com/support/ljM701 or www.hp.com/support/ljM706.

Outside the US, go to www.hp.com/support. Select your country/region. Click Troubleshooting. Enter the
product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Change the product connection type (Windows)
If you are already using the product and you wish to change the way it is connected, use the Reconfigure
your HP Device shortcut on your computer desktop to change the connection. For example, you can
reconfigure the product to use a different wireless address, to connect to a wired or wireless network, or
change from a network connection to a USB connection. You can change the configuration without inserting
the product CD. After you select the type of connection you wish to make, the program goes directly to the
portion of the product setup procedure that needs to change.
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Configure IP network settings
● Printer sharing disclaimer

● View or change network settings

● Rename the product on a network

● Manually configure IPv4 TCP/IP parameters from the control panel

Printer sharing disclaimer
HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems
and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

View or change network settings
Use the HP Embedded Web Server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.

a. On the control panel, press the OK button.

b. Scroll to the Reports menu, and then press the OK button.

c. Scroll to the Configuration Report option, and then press the OK button to print the report.

2. Open a Web browser, and in the address line, type the IP address exactly as it displays on the product
control panel. Press the Enter key on the computer keyboard. The EWS opens.

3. Click the Networking tab to obtain network information. Change settings as needed.

Rename the product on a network
If you want to rename the product on a network so that it can be uniquely identified, use the HP Embedded
Web Server.

1. Print a configuration page, and locate the IP address.

a. On the control panel, press the OK button.

b. Scroll to the Reports menu, and then press the OK button.

c. Scroll to the Configuration Report option, and then press the OK button to print the report.

2. Open a Web browser, and in the address line, type the IP address as it displays on the product control
panel. Press the Enter key on the computer keyboard. The EWS opens.

3. Open the System tab.

4. On the Device Information page, the default product name is in the Device Status field. You can change
this name to uniquely identify this product.
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NOTE: Completing the other fields on this page is optional.

5. Click the Apply button to save the changes.

Manually configure IPv4 TCP/IP parameters from the control panel
Use the control-panel menus to manually set an IPv4 address, subnet mask, and default gateway.

1. On the product control panel, press the OK button.

2. Open the following menus:

● Network Setup

● IPV4 Config Method

● Manual

3. Use the arrow keys to enter the IP address, and press the OK button. Press the OK button again to
confirm.

4. Use the arrow keys to enter the subnet mask, and press the OK button. Press the OK button again to
confirm.

5. Use the arrow keys to enter the default gateway, and press the OK button. Press the OK button again to
confirm.
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Advanced configuration with HP Embedded Web Server (EWS)
and HP Device Toolbox (Windows)

Use the HP Embedded Web Server to manage printing functions from your computer instead of the product
control panel.

● View product status information

● Determine the remaining life for all supplies and order new ones

● View and change tray configurations

● View and change the product control-panel menu configuration

● View and print internal pages

● Receive notification of product and supplies events

● View and change network configuration

The HP Embedded Web Server works when the product is connected to an IP-based network. The HP
Embedded Web Server does not support IPX-based product connections. You do not have to have Internet
access to open and use the HP Embedded Web Server.

When the product is connected to the network, the HP Embedded Web Server is automatically available.

NOTE: HP Device Toolbox is available only if you performed a full installation when you installed the
product. Depending on how the product is connected, some features might not be available.

NOTE: The HP Embedded Web Server is not accessible beyond the network firewall.

Open the HP Embedded Web Server (EWS) from the Start menu

1. Click the Start button, and then click the Programs item.

2. Click your HP product group, and then click the HP Device Toolbox item.

Open the HP Embedded Web Server (EWS) from a Web browser

1. Print a configuration page, and locate the IP address.

a. On the control panel, press the OK button.

b. Scroll to the Reports menu, and then press the OK button.

c. Scroll to the Configuration Report, and then press the OK button to print the report.

2. Open a Web browser, and in the address line, type the IP address as it displays on the product control
panel. Press the Enter key on the computer keyboard. The EWS opens.
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Tab or section Description

Home tab

Provides product, status, and
configuration information.

● Device Status: Shows the product status and shows the approximate percent life
remaining of HP supplies.

● Supplies Status: Shows the approximate percent life remaining of HP supplies. Actual
supply life remaining can vary. Consider having a replacement supply available to install
when print quality is no longer acceptable. The supply does not need to be replaced
unless the print quality is no longer acceptable.

● Device Configuration: Shows the information found on the product configuration page.

● Network Summary: Shows the information found on the product network configuration
page.

● Reports: Print the configuration and supplies status pages that the product generates.

● Event Log: Shows a list of all product events and errors.

System tab

Provides the ability to configure the
product from your computer.

● Device Information: Provides basic product and company information.

● Paper Setup: Change the default paper-handling settings for the product.

● Print Quality: Change the default print-quality settings for the product.

● EcoSMART Console: Change the default times for entering Sleep mode or Auto Power
Down mode. Configure which events cause the product to wake.

● Paper Types: Configure print modes that correspond to the paper types that the product
accepts.

● System Setup: Change the system defaults for the product.

● Service: Perform the cleaning procedure on the product.

● Save and Restore: Save the current settings for the product to a file on the computer.
Use this file to load the same settings onto another product or to restore these settings
to this product at a later time.

● Administration: Set or change the product password. Enable or disable product features.

NOTE: The System tab can be password-protected. If this product is on a network, always
consult with the administrator before changing settings on this tab.

Print tab

Provides the ability to change
default print settings from your
computer.

● Printing: Change the default product print settings, such as number of copies and paper
orientation. These are the same options that are available on the control panel.

● PCL5c: View and change the PCL5c settings.

● PostScript: Turn off or on the Print PS Errors feature.

Fax tab

(Fax products only)

● Receive Options: Configure how the product handles incoming faxes.

● Phone Book: Add or delete entries in the fax phone book.

● Junk Fax List: Set fax numbers to block from sending faxes to the product.

● Fax Activity Log: Review recent fax activity for the product.
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Tab or section Description

Scan tab

(MFP products only)

Configure the Scan to Network Folder and Scan to E-mail features.

● Network Folder Setup: Configure folders on the network to which the product can save a
scanned file.

● Scan to E-mail Setup: Begin the process to set up the Scan to E-mail feature.

● Outgoing E-mail Profiles: Set an email address that will appear as the “from” address
for all emails sent from the product. Configure the SMTP Server information.

● E-mail Address Book: Add or delete entries in the email address book.

● E-mail Options: Configure a default subject line and body text. Configure default scan
settings for emails.

Networking tab

(Network-connected products only)

Provides the ability to change
network settings from your
computer.

Network administrators can use this tab to control network-related settings for the product
when it is connected to an IP-based network. It also allows the network administrator to set
up Wireless Direct functionality. This tab does not appear if the product is directly connected
to a computer.

HP Web Services tab Use this tab to set up and use various Web tools with the product.

HP Smart Install tab Use this tab to disable HP Smart Install or to download and install the product software.
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HP Utility for Mac OS X
Use the HP Utility for Mac OS X to check product status or to view or change product settings from your
computer.

You can use the HP Utility when the product is connected with a USB cable or is connected to a TCP/IP-based
network.

For more information, see www.hp.com/support.

Open HP Utility
1. At the computer, open the Apple  menu, click the System Preferences menu, and then click the Print

& Fax icon or the Print & Scan icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Utility tab.

5. Click the Open Printer Utility button.

HP Utility features
The HP Utility toolbar is at the top of every page. It includes these items:

● Devices: Click this button to show or hide Mac products found by the HP Utility in the Printers pane at
the left side of the screen.

● All Settings: Click this button to return to the HP Utility main page.

● HP Support: Click this button to open a browser and go to the HP support Web site for the product.

● Supplies: Click this button to open the HP SureSupply Web site.

● Registration: Click this button to open the HP registration Web site.

● Recycling: Click this button to open the HP Planet Partners Recycling Program Web site.

HP Utility consists of pages that you open by clicking in the All Settings list. The following table describes the
tasks that you can perform with HP Utility.

Menu Item Description

Information And Support Supplies Status Show the product supplies status and provides links for ordering
supplies online.

 Device Information Show information about the currently selected product, including
the product Service ID (if assigned), the firmware version (FW
Version), the Serial Number, and the IP address.
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Menu Item Description

 File Upload Transfer files from the computer to the product. You can upload
the following types of files:

● HP LaserJet printer command language (.PRN)

● Portable document format (.PDF)

● Postscript (.PS)

● Text (.TXT)

 HP Connected Access the HP Connected Web site.

 Upload Fonts Upload fonts from your computer to the product.

Printer Settings Auto-off Configure the product to automatically turn off after a period of
inactivity. You can adjust the number of minutes after which the
product turns off.

 Network Settings Configure the network settings, such as the IPv4 settings, IPv6
settings, Bonjour settings, and other settings.

 Supplies Management Configure how the product should behave when supplies are
nearing the end of their estimated life.

 Trays Configuration Change paper size and type for each of the trays.

 Additional Settings Open the HP Embedded Web Server (EWS) for the product.

NOTE: USB connections are not supported.

Information Message Center Display error events that have occurred with the product.

Scan Settings Scan to E-mail Open the HP Embedded Web Server (EWS) page for configuring
settings for scanning to email.

NOTE: USB connections are not supported.

 Scan to Network Folder Open the HP Embedded Web Server (EWS) page for configuring
settings for scanning to a network folder.

NOTE: USB connections are not supported.
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HP Web Jetadmin
HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of
networked HP products, including printers, multifunction products, and digital senders. This single solution
allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and imaging
environment — ultimately increasing business productivity by helping you save time, control costs, and
protect your investment.

HP Web Jetadmin upgrades are periodically made available to provide support for specific product features.
Go to www.hp.com/go/webjetadmin and click the Self Help and Documentation link to learn more about
upgrades.
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Product security features
The product supports security standards and recommended protocols that help you keep the product secure,
protect critical information on your network, and simplify the way you monitor and maintain the product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/
secureprinting. The site provides links to white papers and FAQ documents about security features.

Set or change the product password using the HP Embedded Web Server
Use the HP Embedded Web Server to set a password or change an existing password for a product on a
network.

1. Print a configuration page, and locate the IP address.

a. On the control panel, press the OK button.

b. Scroll to the Reports menu, and then press the OK button.

c. Scroll to the Configuration Report, and then press the OK button to print the report.

2. Open a Web browser, and in the address line, type the IP address exactly as it displays on the product
control panel. Press the Enter key on the computer keyboard. The EWS opens.

3. Click the System tab, and click either the Product Security or the Administration link.

NOTE: If a password has previously been set, you are prompted to provide the password. Enter the
password, and then click the Apply button.

4. Enter the new password in the Password box and in the Confirm Password box.

5. At the bottom of the window, click the Apply button to save the password.

NOTE: For products connected with a USB cable to a Windows computer, use the HP Device Toolbox to
change the product password:

1. Click the Start button, and then click the Programs item.

2. Click your HP product group, and then click the HP Device Toolbox item.

3. Click the System tab.

4. Click Administration, and locate the area to change the password.
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Economy settings
● Print with EconoMode

● Set the Sleep Delay

● Set the Auto Power Down delay

Print with EconoMode
This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less toner.
However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply
might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer
acceptable, consider replacing the toner cartridge.

NOTE: If this option is not available in your print driver, you can set it using the HP Embedded Web Server.

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the EconoMode check box.

Set the Sleep Delay
1. On the product control panel, press the OK button.

2. Open the following menus:

● System Setup

● Energy Settings

● Sleep Delay

3. Select the time for the sleep delay, and then press the OK button.

NOTE: The default value is 15 Minutes.

Set the Auto Power Down delay

NOTE: This setting is not available on all products.

1. On the product control panel, touch the OK button.

2. Open the following menus:

● System Setup

● Energy Settings

● Auto Power Down

● Power Down Delay
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3. Select the time for the power-down delay.

NOTE: The default value is 30 Minutes.

4. The product automatically wakes from the auto power-down mode when it receives jobs or when you
touch the screen on the product control panel. You can change which events cause the product to wake.
Open the following menus:

● System Setup

● Energy Settings

● Auto Power Down

● Wake Events

To turn off a wake event, select the event, clear the check box next to it and then press the OK button.

ENWW Economy settings 53



Update the firmware
HP offers periodic product updates, new Web Services apps, and new features to existing Web Services apps.
Follow these steps to update the product firmware for a single product. When you update the firmware, Web
Service apps will update automatically.

There are two supported methods to perform a firmware update on this product. Use only one of the
following methods to update the product firmware.

Method one: Update the firmware using the control panel
Use these steps to load the firmware from the control panel (for network-connected products only), and/or
set the product to automatically load future firmware updates. For USB-connected products, skip to method
two.

1. Make sure the product is connected to a wired (Ethernet) network with an active Internet connection.

NOTE: The product must be connected to the Internet to update the firmware via a network
connection.

2. On the product control panel, press the OK button.

3. Open the following menus:

● Service

● LaserJet Update

4. Scroll to the Check for Updates Now option, and press the OK button.

NOTE: The product automatically checks for an update, and if a newer version is detected, the update
process automatically starts.

5. Set the product to automatically update the firmware when updates become available.

a. On the product control panel, press the OK button.

b. Open the following menus:

● Service

● LaserJet Update

● Manage Updates

c. Set the Allow Updates option to YES, and then set the Automatic Check option to ON. Press the
OK button.

Method two: Update the firmware using the Firmware Update Utility
Use these steps to manually download and install the Firmware Update Utility from HP.com.

NOTE: This method is the only firmware update option available for products connected to the computer
via a USB cable. It also works for products connected to a network.
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1. Go to www.hp.com/go/support, click the Drivers & Software link, type the product name in the search
field, press the ENTER button, and then select the product from the list of search results.

2. Select the operating system.

3. Under the Firmware section, locate the Firmware Update Utility.

4. Click Download, click Run, and then click Run again.

5. When the utility launches, select the product from the drop-down list, and then click Send Firmware.

NOTE: To print a configuration page to verify the installed firmware version before or after the update
process, click Print Config.

6. Follow the on-screen instructions to complete the installation, and then click the Exit button to close
the utility.
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6 Solve problems

● Customer support

● Restore the factory-set defaults

● A “Cartridge is low” or “Cartridge is very low” message displays on the product control panel

● Product does not pick up paper or misfeeds

● Clear jams

● Improve print quality

● Solve wired network problems

For more information:

In the US, go to www.hp.com/support/ljM701 or www.hp.com/support/ljM706.

Outside the US, go to www.hp.com/support. Select your country/region. Click Troubleshooting. Enter the
product name, and then select Search.

HP's all-inclusive help for your product includes the following information:

● Install and configure

● Learn and use

● Solve problems

● Download software updates

● Join support forums

● Find warranty and regulatory information
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Customer support
Get telephone support for your country/region

Have the product name, serial number, date of purchase, and
problem description ready.

Country/region phone numbers are on the flyer that was in the
box with your product or at www.hp.com/support/.

Get 24-hour Internet support, and download software utilities,
drivers, and electronic information

www.hp.com/support/ljM701 or www.hp.com/support/ljM706

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register your product www.register.hp.com
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Restore the factory-set defaults
Restoring the factory-set defaults returns all of the product and network settings to the factory defaults. It
will not reset the page count, tray size, or language. To restore the product to the factory-default settings,
follow these steps.

CAUTION: Restoring the factory-set defaults returns all of the settings to the factory defaults, and it also
deletes any pages that are stored in the memory. The procedure then automatically restarts the product.

1. On the product control panel, press the OK button to open the menus.

2. Open the following menus:

● Service

● Restore Defaults

The product automatically restarts.
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A “Cartridge is low” or “Cartridge is very low” message displays
on the product control panel

Cartridge is low: The product indicates when a toner cartridge level is low. Actual toner cartridge life
remaining may vary. Consider having a replacement available to install when print quality is no longer
acceptable. The toner cartridge does not need to be replaced now.

Cartridge is very low: The product indicates when the toner cartridge level is very low. Actual toner cartridge
life remaining may vary. Consider having a replacement available to install when print quality is no longer
acceptable. The toner cartridge does not need to be replaced now unless the print quality is no longer
acceptable.

Once an HP toner cartridge has reached Very Low, HP’s Premium Protection Warranty on that toner cartridge
has ended.

Change the “Very Low” settings
Use the product control panel to change the way the product reacts when supplies reach the Very Low state.
It is not necessary to re-establish these settings after installing a new toner cartridge.

1. On the product control panel, press the OK button.

2. Open the following menus:

● System Setup

● Supply Settings

● Black Cartridge

● Very Low Setting

3. Select one of the following options:

● Select the Stop option to set the product to stop printing when the cartridge reaches the Very Low
threshold.

● Select the Prompt option to set the product to stop printing when the cartridge reaches the Very
Low threshold. Acknowledge the prompt or replace the cartridge to resume printing.

● Select the Continue option to set the product to display an alert that the cartridge is very low, and
to continue printing beyond the Very Low setting without interaction. This can result in
unsatisfactory print quality.

Order supplies

Order supplies and paper www.hp.com/go/suresupply

Order through service or support providers Contact an HP-authorized service or support provider.

Order using the HP Embedded Web Server (EWS) To access, in a supported Web browser on your computer, enter
the product IP address or host name in the address/URL field. The
EWS contains a link to the HP SureSupply Web site, which
provides options for purchasing Original HP supplies.
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Product does not pick up paper or misfeeds
● The product does not pick up paper

● The product picks up multiple sheets of paper

The product does not pick up paper
If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper size and type are set correctly on the product control panel.

4. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to
the appropriate indentation in the tray.

5. Check the product control panel to see if the product is waiting for you to acknowledge a prompt to feed
the paper manually. Load paper, and continue.

6. The rollers above the tray might be contaminated. Clean the rollers with a lint-free cloth dampened
with warm water.

The product picks up multiple sheets of paper
If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan
the paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten
the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides to
the appropriate indentation in the tray.

6. Make sure the printing environment is within recommended specifications.
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Clear jams
Jam locations

Jams can occur in these locations:

3

1

2

3
6

74

5

1 Output bin

2 Print cartridge area

3 Tray 1

4 Tray 2

5 Optional Tray 3 (M706n model only)

6 Rear door

7 Duplex unit area (M706n model only)

Loose toner might remain in the product after a jam. This problem typically resolves itself after a few sheets
have been printed.

Experiencing frequent or recurring paper jams?
To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten
the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so
they are touching the paper stack without bending it.

6. Make sure that the tray is fully inserted in the product.
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7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and feed
sheets one at a time.

8. Verify that the tray is configured correctly for the paper type and size.

a. On the product control panel, press the OK button.

b. Open the following menus:

● System Setup

● Paper Setup

c. Verify the tray is configured for the paper type and size.

9. Make sure the printing environment is within recommended specifications.

Clear jams in Tray 1

1. If most of the sheet of paper is visible in the tray,
slowly pull the jammed paper out of the product
using both hands.

If most of the sheet of paper has been pulled
inside the product or no paper is visible, continue
with the following steps.

 

2. Open the front door.  

ENWW Clear jams 63



3. Remove the toner cartridge.  

4. Lift the jam-plate and carefully remove any
jammed paper. Use both hands to remove
jammed paper to avoid tearing the paper.

 

64 Chapter 6   Solve problems ENWW



5. Reinsert the toner cartridge.  

6. Close the front door.  

Clear jams in Tray 2

1. Remove the tray from the product.  
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2. Remove the paper from the tray, and discard any
damaged paper.

 

3. Make sure the paper guides are adjusted for the
correct paper size. If necessary, unlock the tray
using the slide lock at the rear of the tray, and
then adjust to the correct paper size.

 

4. Load the paper into the tray. Make sure that the
stack is flat at all four corners and that the top of
the stack is below the maximum-height
indicators.
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5. Reinsert and close the tray.  

6. Open the front door.  

7. Remove the toner cartridge.  
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8. Lift the jam-plate and carefully remove any
jammed paper. Use both hands to remove
jammed paper to avoid tearing the paper.

 

9. Reinsert the toner cartridge.  

10. Close the front door.  
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Clear jams in Tray 3 (M706n model only)

1. Remove the tray from the product.  

3

2. Remove the paper from the tray, and discard any
damaged paper.

 

3

3. Make sure the paper guides are adjusted for the
correct paper size.

 

3
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4. Load the paper into the tray. Make sure that the
stack is flat at all four corners and that the top of
the stack is below the maximum-height
indicators.

 

3

5. Reinsert and close the tray.  

3

6. Open the front door.  
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7. Remove the toner cartridge.  

8. Lift the jam-plate and carefully remove any
jammed paper. Use both hands to remove
jammed paper to avoid tearing the paper.
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9. Reinsert the toner cartridge.  

10. Close the front door.  

Clear jams in the toner-cartridge area

1. Open the front door.  
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2. Remove the toner cartridge.  

3. Lift the jam-plate and carefully remove any
jammed paper. Use both hands to remove
jammed paper to avoid tearing.
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4. Reinsert the toner cartridge.  

5. Close the front door.  

Clear jams in the rear door and fuser area

1. Open the front door.  
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2. Open the rear door to check for jammed paper.  

3. Remove any jammed paper. Use both hands to
pull out the paper to avoid tearing.
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4. Close the rear door.  

5. Close the front door.  

Clear jams in the output bin

1. If paper is visible in the output bin, grasp the
leading edge with both hands and slowly remove
it.

 

76 Chapter 6   Solve problems ENWW



2. Open the rear door to check for jammed paper.  

3. Remove any jammed paper. Use both hands to
pull out the paper to avoid tearing.

 

4. Close the rear door.  
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Clear jams in the optional duplexer (M706n model only)

1. Remove the duplexer.  

2. Remove any paper from the duplexer.  

3. Reinstall the duplexer.  
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Improve print quality
If the product is having print-quality problems, try the following solutions in the order presented to resolve
the issue.

● Print from a different software program

● Check the paper-type setting for the print job

● Check the toner-cartridge status

● Print a cleaning page

● Visually inspect the toner cartridge for damage

● Check paper and the printing environment

● Check other print job settings

● Try a different print driver

Print from a different software program
Try printing from a different software program. If the page prints correctly, the problem is with the software
program from which the page was printed.

Check the paper-type setting for the print job
Check the paper type setting when printing from a software program and the printed pages have smears,
fuzzy or dark print, curled paper, scattered dots of toner, loose toner, or small areas of missing toner.

Check the paper type setting (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper Type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper.

7. Select the option for the type of paper being used, and click the OK button.

8. Click the OK button to close the Document Properties dialog box. In the Print dialog box, click the OK
button to print the job.

Check the paper type setting (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list, and then
click the Finishing menu.
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4. Select a type from the Media Type drop-down list.

5. Click the Print button.

Check the toner-cartridge status
Check the supplies status page for the following information:

● Estimated percentage of cartridge life remaining

● Approximate pages remaining

● Part numbers for HP toner cartridges

● Number of pages printed

Use the following procedure to print the supplies status page:

1. On the product control panel, press the OK button.

2. Scroll to the Reports menu, and press the OK button.

3. Scroll to the Supplies Status option, and then press the OK button to print a report of the status of all
supply items.

4. Check the percent of life remaining for the toner cartridge and if applicable, the status of other
replaceable maintenance parts.

Print quality problems can occur when using a toner cartridge that is at its estimated end of life. The
supplies status page indicates when a supply level is very low. After an HP supply has reached the very
low threshold, HP’s premium protection warranty on that supply has ended.

The toner cartridge does not need to be replaced now unless the print quality is no longer acceptable.
Consider having a replacement available to install when print quality is no longer acceptable.

If a toner cartridge or other replaceable maintenance part needs to be replaced, the supplies status
page lists the genuine HP part numbers.

5. Check to see if a genuine HP cartridge is installed.

A genuine HP toner cartridge has the word “HP” on it, or has the HP logo on it. For more information on
identifying HP cartridges go to www.hp.com/go/learnaboutsupplies.

HP cannot recommend the use of non-HP supplies, either new or remanufactured. Because they are not
HP products, HP cannot influence their design or control their quality. If you are using a refilled or
remanufactured toner cartridge and are not satisfied with the print quality, replace the toner cartridge
with a genuine HP toner cartridge.

Print a cleaning page
During the printing process paper, toner, and dust particles can accumulate inside the product and can cause
print-quality issues such as toner specks or spatter, smears, streaks, lines, or repeating marks.

Follow these steps to clean the product's paper path.

80 Chapter 6   Solve problems ENWW

http://www.hp.com/go/learnaboutsupplies


1. On the product control panel, press the OK button.

2. Scroll to the Service menu, and press the OK button.

3. Scroll to the Cleaning Page option, and press the OK button.

A Cleaning message displays on the product control panel. The cleaning process takes a few minutes to
complete. Do not turn the product off until the cleaning process has finished. When it is finished, discard
the printed page.

Visually inspect the toner cartridge for damage
1. Remove the toner cartridge from the product, and verify that the sealing tape has been removed.

2. Check the memory chip for damage.

3. Examine the surface of the imaging drum on the toner cartridge.

CAUTION: Do not touch the roller (imaging drum) on the cartridge. Fingerprints on the imaging drum
can cause print-quality problems.

4. If there are any scratches, fingerprints, or other damage on the imaging drum, replace the toner
cartridge.

5. If the imaging drum does not appear to be damaged, rock the toner cartridge gently several times and
reinstall it. Print a few pages to see if the problem has resolved.

Check paper and the printing environment

Step one: Use paper that meets HP specifications

Some print-quality problems arise from using paper that does not meet HP specifications.

● Always use a paper type and weight that this product supports.

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles,
voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that does not contain metallic material, such as glitter.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use in
Inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.

Step two: Check the environment

The environment can directly affect print quality and is a common cause for print-quality or paper-feeding
issues. Try the following solutions:

● Move the product away from drafty locations, such as open windows or doors, or air-conditioning vents.

● Make sure the product is not exposed to temperatures or humidity outside of product specifications.

● Do not place the product in a confined space, such as a cabinet.
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● Place the product on a sturdy, level surface.

● Remove anything that is blocking the vents on the product. The product requires good air flow on all
sides, including the top.

● Protect the product from airborne debris, dust, steam, grease, or other elements that can leave residue
inside the product.

Check other print job settings
When printing from a software program, follow these steps to try to resolve the issue by adjusting other
print-driver settings.

Check the EconoMode settings

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply
might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer
acceptable, consider replacing the toner cartridge.

NOTE: This feature is available with the PCL 6 print driver for Windows. If you are not using that driver,
enable the feature by using the HP Embedded Web Server.

Follow these steps if the entire page is too dark or too light.

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab, and locate the Print Quality area.

4. If the entire page is too dark, use these settings:

● Select the 600 dpi option.

● Select the EconoMode check box to enable it.

If the entire page is too light, use these settings:

● Select the FastRes 1200 option.

● Clear the EconoMode check box to disable it.

5. Click the OK button to close the Document Properties dialog box. In the Print dialog, click the OK button
to print the job.

Try a different print driver
Try a different print driver when printing from a software program and the printed pages have unexpected
lines in graphics, missing text, missing graphics, incorrect formatting, or substituted fonts.

Download any of the following drivers from the HP Web site. In the US, go to www.hp.com/support/ljM701 or
www.hp.com/support/ljM706. Outside the US, go to www.hp.com/support. Select your country/region. Click
Download Drivers & Software. Enter the product name, and then select Search.
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HP PCL 6 driver ● Provided as the default driver on the product CD. This driver is automatically
installed unless a different one is selected.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the best
speed in Windows environments

● Might not be fully compatible with third-party and custom software programs that
are based on PCL 5

HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other highly
graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript
flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single driver for
use with multiple product models

● Preferred when printing to multiple product models from a mobile Windows
computer

HP UPD PCL 6 ● Recommended for printing in all Windows environments

● Provides the overall best speed, print quality, and printer feature support for most
users

● Developed to align with Windows Graphic Device Interface (GDI) for best speed in
Windows environments

● Might not be fully compatible with third-party and custom software programs that
are based on PCL 5
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Solve wired network problems
Check the following items to verify that the product is communicating with the network. Before beginning,
print a configuration page from the product control panel and locate the product IP address that is listed on
this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

NOTE: HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating
systems and not of the HP print drivers. For more information, go to Microsoft at www.microsoft.com.

Poor physical connection
1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity light
and the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product
1. Open the printer properties and click the Ports tab. Verify that the current IP address for the product is

selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always print to
this printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of the IP
address.

4. If the IP address is correct, delete the product and then add it again.

The computer is unable to communicate with the product
1. Test network communication by pinging the network.
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a. Open a command-line prompt on your computer. For Windows, click Start, click Run, type cmd,
and then press Enter.

b. Type ping followed by the IP address for your product.

For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in the
Ping pane.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network
HP recommends leaving these settings in automatic mode (the default setting). If you change these settings,
you must also change them for your network.

New software programs might be causing compatibility problems
Verify that any new software programs are correctly installed and that they use the correct print driver.

The computer or workstation might be set up incorrectly
1. Check the network drivers, print drivers, and the network redirection settings.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect
1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.
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